
Teacher Guide

Lessons for Middle and High School Students: Grades 7-12 

Technology Course using 

Google Sheets
Draft a budget for a shopping spree. 

In this course, students develop financial literacy using a problem-solving model. The fun 

begins with a windfall and shopping spree. Students create a budget and spending plan. 

They use Google Sheets to organize, calculate, and graph data. A report is written using 

Google Docs to justify financial choices and share insights about money management. 

To start, students are introduced to budgeting and rate their money management style. Next, 

they practice basic spreadsheet skills. Once familiar with Google Sheets, they determine a 

budget and allocate funds into categories with the assistance of a pie graph. Next, they 

design a spending table that calculates taxes, tracks totals, and highlights overspending. A 

bar graph is created of the spending plan. Once they have made their purchasing decisions 

Google Docs is used to write a summary report with graphs to support reasoning. 

Challenging enrichment activities extend learning. Students can comparison shop, use 

functions to analyze data, filter and sort, calculate with if-then formulas, manipulate debt 

repayment, build consumer awareness, and draw money idioms. 
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Introduction 

 

Introduction 

 

This section provides valuable information about teaching TechnoBudget. It 

includes an overview of the course. In addition, there are ideas for 

implementation and technology integration. 

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 

TechnoBudget Overview 

TechnoBudget Course Outline 

Technology Integration Ideas 
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TechnoBudget Overview 

In this course, students develop financial literacy using a problem-solving 

model. The fun begins with a windfall and shopping spree. Students create a 

budget and spending plan. They use Google Sheets to organize, calculate, and 

graph data. A report is written using Google Docs to justify financial choices 

and share insights about money management. 

Students complete the following tasks: 

➢ In Session 1, students participate in a financial literacy simulation. In it, they receive 

an imaginary windfall of money. They cannot spend it all in one place. Instead, 

they must form a spending plan that includes saving some of the funds. To start, 

they rate their money management style to determine if they are a spender or a 

saver. Next, they explore spreadsheets to discover how this tool can be used to 

organize information. An optional activity has students illustrate popular idioms such 

as "I am broke", "I am on a shoestring budget" or "Do you think I am made of 

money?". This is a fun way to consider how people talk about money. 

➢ In Session 2, students use a spreadsheet to set a budget for their windfall. To start, 

they divide the money into spending categories, such as savings, clothing, 

entertainment, or electronics. No category can be less than 5% or more than 50%. 

To determine if the budget is reasonable, they graph the data to show the 

information as a pie chart. This makes it easy to see the percentages of money for 

each category. Based on the results, students can adjust their budget. Do they 

need to allocate more money or less money to a category? 

➢ In Session 3, students create a spending plan that will track the things they would 

like to buy. Using a spreadsheet, students create a worksheet that lists items, 

calculates taxes, and shows a grand total. By applying conditional formatting to 

cells, it becomes easy to spot overspending. After testing the worksheet to make 

sure that it works, students delete the data. This will get the spreadsheet ready for 

the next Session, when it is time to plan a shopping spree. 

➢ In Session 4, students plan a shopping spree. They visit online stores to find items 

they would like to purchase. The information is tracked using a worksheet. There is 

no need to spend every dollar. Extra money can be allocated to savings or charity. 

If their planned purchases go over by a few dollars in one category, this means 

they must reduce spending in another. Once the plan is complete, they analyze 

their data using functions. This will help them determine if they are 'on budget'. 

Optional activities have students become thoughtful shoppers. They can 

comparison shop to find the best deal or investigate corporate responsibility to 

determine if a company deserves their money. 

➢ In Session 5, students graph the data in their spending plan to see where their 

money will go. A bar graph makes it easy to compare purchases from each 

category. They format the data and then analyze the information to determine if 

they need to make changes to their plan. Extension activities focus on studying 

small sets of data. Instructions explain how to filter and sort data. As well, optionally 

students can produce a comparison chart of categories by calculating data from 

another worksheet using a formula that includes SUMIF. 

➢ In Session 6, students write a report that justifies their financial decisions. This 

document will include an explanation for their windfall, an outline of the budget, 

and a summary of their planned purchases. Graphs from the spreadsheet will 

illustrate their plan. The publication will conclude with insights into what students 

learned about their money management style. An optional activity about credit 

and debt explains how to use a spreadsheet to calculate interest and monthly 

payments. This is a great way to understand the cost of borrowing money. 
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TechnoBudget Course Outline 
  

Purpose: Develop money management skills. 

Create a budget and spending plan using 

Google Sheets to guide financial decisions.  

Preparation: 

• Install Google Chrome 

• Sign up for a Google account 

• Share Budget folder with students 

• Download and print Flashcards and Tool 

Summary from TechnHub (optional) 

 

Objectives: (see Appendix A: Skill Summary) 

• develop financial literacy 

• problem solve to make decisions 

• organize data using spreadsheets 

• determine a budget 

• create a spending plan 

• format a worksheet 

• calculate data using formulas 

• graph data 

• justify financial choices 

• report financial decisions  

• compare purchasing options (optional) 

• sort and filter data (optional) 

• understand credit and debt (optional) 

• develop consumer awareness (optional) 

Materials: 

• Spreadsheet Checklist, TechnoBudget Skill 

Summary, Spreadsheet Marking Sheet, Report 

Marking Sheet 

• Budget folder 

o Samples: Budget Workbook, Budget Report 

• Samples: Budget Workbook, Budget Report, 

idiom.png 

• Parent Letter and Certificate (optional) 

• Flashcards and Tool Summary (optional) 
  

 

Summary of Activities: 

• Rate money management style. 

• Explain a practical reason for a financial windfall. 

• Learn spreadsheet terminology and practice basic skills. 

• Divide a budget into categories. Use AutoSum to calculate totals. 

• Create a pie graph of the budget. Adjust it based on the percentage allocated for each category. 

• Design a spending plan table. Calculate taxes, track totals, and highlight overspending. 

• Visit online stores. Make purchasing decisions and record information in the spending plan table. 

• Create a bar graph of the spending plan. Examine the allocation of funds. 

• Use Functions to Analyze Spending: Calculate sum, average, minimum, maximum, and count. 

• Complete a worksheet checklist. 

• Justify financial choices in a report. Use graphs to support reasoning. 

 

Extension Activities: 

• Have Fun with Money Idioms: Use Google Drawings to illustrate a popular saying about money. 

• Compare Purchasing Options: Research to locate the best deal for an item. 

• Build Consumer Awareness: Rate corporate responsibility.  

• Filter and Sort Data: Sort data alphabetically and numerically. Filter by condition or value. 

• Comparison Table and Graph: Use if-then formulas to summarize data in each category. 

• Understand Credit and Debt: Calculate the cost of borrowing and the time needed for repayment. 
 

 

Assessment: 

• Self-Evaluation (Spreadsheet Checklist) 

• Teacher Evaluation (TechnoBudget Skill Summary, Spreadsheet Marking Sheet, Report Marking 

Sheet) 
 

 

Notes: 

• The course activities are designed for students in Grades 6-9. Some of the extension activities use 

advanced spreadsheet skills that are more suitable for older children. 

• The spending plan is designed using online stores. Alternatively, you could bring in store sales flyers. 

• Encourage your students to shop from online stores that use local currency. 
 

  

https://technohub.technokids.com/


  Getting Started 

Copyright © TechnoKids Inc. iv TechnoBudget | Google Workspce 

Technology Integration Ideas 

Money management is an essential life skill. The activities in TechnoBudget develop financial 

literacy using a scenario that is understandable for children and teenagers. Your students will 

enjoy budgeting to plan a shopping spree. There are several ways to integrate TechnoBudget 

into curriculum: 

 

• Mathematics Personal Finance Unit 

Use the activities in TechnoBudget to motivate students to manage personal finances. 

They learn how to draft a budget, develop a spending plan, and adjust financial 

choices. In addition, extension activities teach students about credit and debit. 

 

 

• Mathematics Problem Solving Unit 

Incorporate TechnoBudget into mathematics to encourage real-world problem solving. 

Drafting a budget and developing a spending plan is a practical task. The activities are 

based on a problem-solving model. Students must apply critical thinking to organize 

ideas, research purchasing options, compare choices, reflect upon their plan, and 

defend reasoning. Once their decisions have been made, a report is written to justify 

financial choices and share insights about money management. 

 

 

• Mathematics Graphing Unit 

TechnoBudget includes activities for graphing data as a pie, column, and bar graph. 

Students add a title, label the horizontal axis and vertical axis, adjust the legend, and set 

value labels. By analyzing graphs, they can understand data and make decisions based 

on the information. The activities apply graphing skills in a meaningful way. 

 

 

• Spreadsheet Unit 

Planning a shopping spree is a great way to engage students in learning about how to 

use a spreadsheet program. Include TechnoBudget as part of a computer course or 

class. Students learn to manage sheets, format cells, calculate data, and graph cell 

ranges. Extension activities provide extra challenges such as filtering and sorting data, 

absolute cell references, if-then formulas, comparison charts, and more.  

 

 

 



 

 

 

Session 1 You Are Rich! 

 

Session 1 

You Are Rich! 

In this session, students participate in a financial literacy simulation. In it, they 

receive an imaginary windfall of money. They cannot spend it all in one place. 

Instead, they must form a spending plan that includes saving some of the 

funds. To start, they rate their money management style to determine if they 

are a spender or a saver. Next, they explore spreadsheets to discover how this 

tool can be used to organize information. An optional activity has students 

illustrate popular idioms such as "I am broke", "I am on a shoestring budget" or 

"Do you think I am made of money?". This is a fun way to consider how people 

talk about money. 

Assignment 1: Money Management and You 

Assignment 2: An Unexpected Windfall! 

Assignment 3: Discover Spreadsheets 

 

Session 1 Extension Activity: Have Fun With Money Idioms 
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Assignment 1: Money Management and You 

You are going to learn how to budget money.  

 

Learn about the importance of having a spending plan.  

Then rate your money management style. Are you a spender or a saver? 

 

What Is a Budget? 

 

A budget lists the items you plan to purchase based on the amount of money you have. When 

you create and follow a spending plan it is called budgeting. A budget must be balanced. The 

items you plan to purchase cannot cost more than the amount of money you have.  

 
 

People use budgets every day. For example, your parents may follow a 

household budget to pay for things your family needs such as utilities, food, and 

entertainment. Your teacher may have been given a trip budget to organize a 

school outing. A team where you are a member may have a club budget that 

they use to organize tournaments or events. 

 

 

Why Have a Budget? 

 

A budget is used to plan what to do with money. A budget helps someone: 

• know their financial situation 

• decide if they have enough money for things that they need 

• prioritize spending so they can buy the things that are important 

• avoid wasting money on purchases 

• save money for purchases or unexpected events 

• keep or get out of debt 

• plan ahead to reach future goals 

 

You and Budgeting 

 

A budget is important. It helps people manage money. Do you budget your money? 
 

1. How do you get money? Check all that apply. 

  allowance  gift 

  chores  other: 

  part time job  

 

2. a. What was the last item you purchased with your own money? 

   
   

 b. Did you have a plan before you bought the item?  yes  no 
   

 c. How might a plan help you when spending your money? 
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Rate Your Money Management Style 

 

Everyone is different. Some people like to spend money, while others like to save it.  

It is a good idea to know your money management style.  

This awareness will help you to monitor your spending behavior and help you to plan ahead. 
 

Are you a saver or a spender? Find out!  
 

For each row, circle the sentence that describes you the MOST. 

 

I like to save money. I like to spend money. 

I pay no attention to brand name. Brand names are important to me. 

I have money saved. I do not have money saved. 

I shop around to get the best price. I buy it when I see it. 

I shop for what I need. I shop for fun. 

Having the latest is not important to me. I like to have the latest. 

I cannot be talked into buying things. I can be talked into buying things. 

When I have money, I can wait to spend it. When I have money, I spend it right away. 

I plan how to spend money before shopping. I wander around stores to find what to buy. 

I keep tabs on the amount of money I spend. I spend my money without keeping track. 

If I do not need it, I do not buy it. I can't resist a bargain, even if not needed. 

I dislike borrowing money. I do not worry about borrowing money. 

I quickly pay back money that I owe. I do not always pay back money I owe. 

SUM SUM 

 

Are You a Spender or a Saver? 

 

Total the number of circles in the left and right columns. 

 

 
 

 
 

Saver 

If you have the greatest number of circles in the LEFT column you are a saver. 
 

You are thoughtful about how you spend your money and do not waste it. You like to 

save just in case you need it later. Unfortunately, sometimes penny pinching can make 

you miss out on fun parts of life. Remember it is okay to splurge from time to time.  

Spender 

If you have the greatest number of circles in the RIGHT column you are a spender. 
 

You enjoy spending money. You like to go to fun places, own lots of stuff, or have the 

finer things in life. Unfortunately, you are at risk for overspending. It is good idea to save 

instead of spending it all. This will give you money in the future in case you need it. 
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Assignment 2: An Unexpected Windfall! 

 
 

An Imaginary Windfall 

 

A windfall is an unexpected gift of money. What would you do if you were richer?  

Now is your chance to find out! 
 

Pretend you received a windfall! You are $750 richer. 

 

1. Think about a practical reason for receiving money: 

  birthday  sold an item  discovery 

  report card  special event  relative 

  test score  achievement  job 

  graduation  holiday  other:   

 

2. Explain how you became $750 richer. 

  

  

 

About the Budget 

 

There are rules or "strings attached" to how the money can be spent. You cannot buy one 

expensive item. Instead, there is a budget you must follow! 
 

Your budget for the windfall must include: 

 

✓ putting money aside for savings 

✓ purchasing items from at least four categories 

✓ limiting the amount that can be spent on any one category 

 

3. Pick the categories for your budget: (pick at least 3 more) 

  savings  clothing  music 

  charity  electronics  entertainment 

  food  gifts  sports equipment 

  other:     
 

 

You are going to 

learn to budget 

and create a 

spending plan. 

 

Great news! You 

have been given 

money. Now what?  

Shopping spree! 

No category can be a monthly 

membership or have recurring fees. 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 2 Create a Budget 

 

Session 2 

Create a Budget 

In this session, students use a spreadsheet to set a budget for their windfall. To 

start, they divide the money into spending categories, such as savings, 

clothing, entertainment, or electronics. No category can be less than 5% or 

more than 50%. To determine if the budget is reasonable, they graph the data 

to show the information as a pie chart. This makes it easy to see the 

percentages of money for each category. Based on the results, students can 

adjust their budget. Do they need to allocate more money or less money to a 

category? 

Assignment 4: Calculate Your Budget 

Assignment 5: Create a Pie Graph and Edit the Budget 
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Assignment 4: Calculate Your Budget 

 
 

Open Budget Workbook in Google Sheets 

 

Add Category Headings 

 

Your Budget worksheet should have a title and a table with borderlines.  

You are now going to add the categories from your budget created in Assignment 2. 

 In cell A3 type Categories. Press ENTER. 

 In cell A4 type Savings. Press ENTER. 

 In cell A5 add another category. 

 Continue to add the categories for spending your windfall. 

 A B 

1 My Budget  

2   

3 Categories  

4 Savings  

5 Charity  

6 Food  

7 Entertainment  

8 Clothing  

9 Electronics  

10   

 

Estimate Amounts for Each Category 

 

How much money do you want to spend on each category? You will edit the amounts later! 

 In cell B3 type Amount. Press ENTER. 

 In cell B4 type a dollar value for Savings. Do not add a $ sign. 

 Continue to add dollar values for each category.  

 Select the cells with the dollar values. Click Format as currency.  

 A B 

1 My Budget  

2   

3 Categories Amount 

4 Savings $10.00 

5 Charity $15.00 

6 Food $50.00 

7 Entertainment $150.00 

8 Clothing $300.00 

9 Electronics $250.00 

10   

  

How much money will 

you spend on each 

category in your budget? 
You will use spreadsheets to 

set a budget. A formula will 

calculate totals. 

It is difficult to know 

if the amounts equal 

$750. You need a 

formula to sum the 

amounts for you! 
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Calculate Amounts for Each Category then Edit Your Budget 

 

You need a formula to sum dollar values. What cells have a dollar value? 

The formula will look something like this: 

 

 
 

 

 

 

 In the cell below the last category type TOTAL. 

 Press TAB to move to the cell beside TOTAL. Click Functions.  

Select SUM. 

 Click and drag to select the cells in the Amount column to  

include in the formula. 

Press ENTER. 

 Edit your budget! The TOTAL must be $750. 

 A B 

1 My Budget  

2   

3 Categories Amount 

4 Savings $10.00 

5 Charity $15.00 

6 Food $50.00 

7 Entertainment $150.00 

8 Clothing $275.00 

9 Electronics $250.00 

10 TOTAL $750.00 
 

Align Text in a Cell 

 Select the cell with the heading TOTAL. 

 Click Horizontal align.  

Pick Right.  

 

Format Budget Table 

 Use your skills to format the budget table. 

o Format the text.           

o Fill a cell with color.  

o Apply borderlines.  

o Align cell content.  

 

Sign Out from Google Drive 

=SUM(B4:B9) 
All calculations begin with the = sign. 

This tells Google Sheets there is a 

formula in the cell. 

SUM means the values in cells 

should be added together. 

(B4:B9) is the cell range. The colon : means to. In other 

words from B4 to B9, which is B4, B5, B6, B7, B8, and B9. 

The cell references are in brackets ( ). 

The amount must 

be $750. If it is not, 

edit your budget. 
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Assignment 5: Create a Pie Graph and Edit the Budget 

 
 

A pie graph is a circle that is divided into parts. The circle is like a pie. Each piece of data is 

shown as a slice of pie. The whole pie is 100%. Each slice of pie is shown as a percentage of the 

whole pie. This type of graph is used to show how something is divided into smaller segments. In 

your case, how the budget is separated into categories. 

 

Viewing the budget as a pie graph will help you to make informed decisions. Ask yourself: 

• Is each category no less than 5% or no more than 50% of the budget? 

• Are the amounts allocated for each category reasonable? 

• Should the amounts be changed? 

 

Open the Budget Workbook in Google Sheets 

 

Create a Pie Graph 

 Select cell A3. It has the Categories heading. 

 Hold the SHIFT key. Select the cell in column B with the last dollar value (above formula). 

 A B 

1 My Budget  

2   

3 Categories Amount 

4 Savings $10.00 

5 Charity $15.00 

6 Food $50.00 

7 Entertainment $150.00 

8 Clothing $275.00 

9 Electronics $250.00 

10 TOTAL $750.00 

 Click Insert chart.  

 Click Setup from the Chart editor sidebar.  

 Click the Chart type arrow  and choose the Pie chart.  

 Select the graph and drag  the chart beside the data table.  

  

Your budget has rules 

you must follow. You can 

spend no less than 5% 

and no more than 50% 

on each category. 

You will make a pie graph 

that shows the percentage 

of money for each 

category. This will allow you 

to edit the budget. 

Select the 

data to graph. 

The size of each piece 

depends on the amount of 

money set for a category. 

The greater the amount, the 

larger the pie piece. 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 4 Stick to the Budget 

 

Session 4 

Stick to the Budget 

In this session, students plan a shopping spree. They visit online stores to find 

items they would like to purchase. The information is tracked using a 

worksheet. There is no need to spend every dollar. Extra money can be 

allocated to savings or charity. If their planned purchases go over by a few 

dollars in one category, this means they must reduce spending in another. 

Once the plan is complete, they analyze their data using functions. This will 

help them determine if they are 'on budget'. Optional activities have students 

become thoughtful shoppers. They can comparison shop to find the best deal 

or investigate corporate responsibility to determine if a company deserves 

their money. 

Assignment 7: Plan a Shopping Spree 

Assignment 8: Use Functions to Analyze Spending Plan 

 

Session 4 Extension Activity 1: Compare Purchasing Options 

Session 4 Extension Activity 2: Build Consumer Awareness 

 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 4 Extension Activity 1: Compare Purchasing Options 

 
 

 

When comparison shopping, consider: 

• Is it a similar item but a different color or style? 

• Is it the same quality but a different model or brand? 

• Is the location close to where you live? 

• If it is an online store are there shipping fees? 

• Is it in stock? 

• Is it new or used? 

• Is it easy to return if you do not like it? 

• Do you receive extra value? 

• Is it more money, but better? 

 

 

1. Open the Budget Workbook in Google Sheets. 

 

2. Add a new sheet: 

 a. Click Add Sheet.  

Or from the Insert menu select New Sheet. 

 b. Click the Sheet3 tab arrow. 

 c. Select Rename. Type Comparison. 

 d. Pick a color for the sheet tab. 

 

3. Add a title: 

 a. In cell A1, type Comparison Shopping.  

 b. Set the font , size , style   , fill  , or alignment.       . 

 

4. Copy headings from the Plan sheet to the Comparison sheet: 

 a. View the Plan sheet. 

 b. Select the headings; Item, Store, Cost, Tax, Total, and Hyperlink. 
 

4 Category Item Store Cost Tax Total Hyperlink 

 

 c. From the Edit menu click Copy.  

 d. View the Comparison sheet. 

 e. Click inside cell A3. 

From the Edit menu click Paste.  

  

Do not waste money by overpaying. 

Find two other stores where you can 

purchase the same or a similar item. 

What is the best deal? 
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5. Copy an item for comparison shopping to the Comparison sheet: 

 a. View the Plan sheet. 

 b. Pick an item to research. Can you find it for less money at another store? 

 c. Select data in Item, Store, Cost, Tax, Total, and Hyperlink. 
 

9 food pizza Pizza Plus $23.00 $3.45 $26.45 www.pizza.com/menu 

 

 d. From the Edit menu click Copy.  

 e. View the Comparison sheet. 

 f. Click inside cell A4. 

From the Edit menu click Paste.  
 

 A B C D E F G 

1 Comparison Shopping  

2        

3 Item Store Cost Tax Total Hyperlink  

4 pizza Pizza Plus $23.00 $3.45 $26.45 www.pizza.com/menu  

 

 

6. It can be difficult to find the identical item when comparison shopping.  

Add the column Comments to record the differences: 

 a. In cell G3, type Comments. 

 b. Select cell F3. Click Paint format.  

 c. Click cell G3 to copy the formatting from one cell to another. 

 

7. Comparison shop: 

 a. Open a new tab in the Chrome browser. Visit online stores. 

 b. Find the same or a similar item.  

 c. Use your skills to include formulas for taxes and totals.  

 d. Complete the Comparison Shopping table: 
 

 A B C D E F G 

1 Comparison Shopping 

2        

3 Item Store Cost Tax Total Hyperlink Comments 

4 pizza Pizza Plus $23.00 $3.45 $26.45 www.pizza.com/menu  

5 pizza deal Pizza Town $24.99 $3.75 $28.74 www.pizzatown.com free pop 

6 pizza supreme Pizza Pie $18.99 $2.85 $21.84 www.pizzapie.com same size, more toppings 

 

8. Add a note to describe the best deal: 

 a. What is the best deal? Select the item. 

 b. From the Insert menu, click Note.  

 c. Type the reason this is the best deal. 

 d. To view the Note, rest the mouse pointer over the cell. 
 

 A B C D E F G 

1 Comparison Shopping 

2        

3 Item Store Cost Tax Total Hyperlink Comments 

4 pizza Pizza Plus $23.00 $3.45 $26.45 www.pizza.com/menu  

5 pizza deal Pizza Town $24.99 $3.75 $28.74 www.pizzatown.com free pop 

6 pizza supreme Pizza Pie $18.99 $2.85 $21.84 www.pizzapie.com same size, more toppings 

 

 

 

9. Edit the spending plan with the best deal. 

  

10. Sign out from Google Drive. 

 

 

Why is this the 

best deal? 

http://www.pizza/
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Session 4 Extension Activity 2: Build Consumer Awareness 

Think beyond the price tag!  

The things you buy have an impact on people and the environment.  
 

It is a good idea to purchase items from companies that are interested in more than 

just making money. Instead, support businesses that behave ethically and 

responsibly. Do they support workers, protect the environment, help communities, and make the 

world a better place? 
 

Pick an item on your spending plan that you would like to purchase. Visit the company website 

that manufactures or sells the product. Look for links that will tell you about corporate 

responsibility, sustainability, or community involvement. If you cannot find anything on the 

website, it may be that these issues are unimportant to the company. 

 

Research Tips: 

• Look at the bottom of the company Home page. 

• Refer to the Site Map. 

• Search for keywords: About, Company, Environment, Sustainability, or Community. 

 

Company  

 

Item Name  

 

Check off each statement that applies to the company: 

 Power facilities using renewable or clean energy. 

 Conserve resources such as water or power. 

 Use eco-friendly materials. 

 Reduce waste with a recycling program.  

 Package or ship products so they minimize environmental impact. 

 Use suppliers that are environmentally and socially responsible. 

 Care about worker's health and safety. 

 Support global or community organizations. 

 Sponsor or participate in fundraising or charity events. 

 Promote education with training, internships, scholarships, or school programs. 

  TOTAL 

 

Add up the checkmarks. Should you spend your money with the company or shop elsewhere? 
 

Buy it Now! 7 checkmarks or more 

The company cares about more than profits. They help people and the environment.  

Go ahead! Make a purchase. 
 

Shop Around!  4-6 checkmarks 

The company is making efforts to help people and the environment. However, they could do 

more. Is there another company that makes or sells the product that you could support instead? 
 

Keep your Cash! 3 checkmarks or less 

The company cares about profits. People and the environment are a low priority. Do not spend 

your money. Shop somewhere else! 



 

 

This is a preview of the teacher guide. 

Pages have been omitted. 



 

 

 

Session 6 Summarize the Budget 

 

Session 6 

Summarize the Budget 

In this session, students write a report that justifies their financial decisions. This 

document will include an explanation for their windfall, an outline of the 

budget, and a summary of their planned purchases. Graphs from the 

spreadsheet will illustrate their plan. The publication will conclude with insights 

into what students learned about their money management style. An optional 

activity about credit and debt explains how to use a spreadsheet to calculate 

interest and monthly payments. This is a great way to understand the cost of 

borrowing money. 

Assignment 10: Spreadsheet Checklist 

Assignment 11: Justify Financial Choices in a Report 

 

Session 6 Extension Activity: Understand Credit and Debt 
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Assignment 10: Spreadsheet Checklist 

  
 

Sign into Google Drive and Open the Workbook 

 

View Each Sheet to Complete the Checklist 

 

Budget Sheet – outlines the amount allocated for each category in the budget  

sheet is named Budget  

title describes the data  

table summarizes the categories in the budget  

budget has four or more categories; one category is savings  

cells on the worksheet are formatted to make the data easy to read  

sum of the Categories totals $750  

Budget Graph – illustrates the budget as a pie graph   

pie graph summarizes the budget  

pie graph includes a title that describes the data   

pie graph includes a labeled legend  

each category is no less than 5% and no more than 50% of the budget  

Plan Sheet – summarizes the items to be purchased as part of a spending plan  

sheet is named Plan  

title describes the data and appears in merged cells  

items on the spending plan total the budgeted amount of $750  

conditional formatting is used to highlight the value of the grand total  

table summarizes items: category, item, store, cost, tax, total, hyperlink  

cells on the worksheet are formatted to make the data easy to read  

dollar values display as currency in the cost, tax, total, and grand total cells  

formulas calculate the taxes, item totals, and a grand total  

sum of items in each category is in line with the budgeted amount  

savings or charity do not include tax  

Chart 1 Sheet – illustrates the spending plan as a graph  

bar or column graph summarizes the spending plan  

title describes the data in the bar or column graph  

legend is removed from the chart area  

graph is formatted to make data easy to read  

bar or column graph appears on its own sheet  

 

Are you ready to report on 

your financial decisions? Or 

do you need to make 

changes? 

Complete 

the checklist. 
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Assignment 11: Justify Financial Choices in a Report 

 
 

Sign into Google Drive and Open the Workbook 

 

Open Google Docs to Create a Report 

 Click the Google Drive browser tab. 

Click New and select Google Docs. 

 Click Untitled document. Type Budget Report. Press ENTER. 

 

Add a Title and Headings 

 Type a title, such as My Spending Plan. 

Press ENTER twice. 

 Add headings to divide the report into sections: 

o Windfall 

o Budget 

o Plan 

o Insights 

 

 

 

 Use your skills to format the text. 

 Make the title and headings stand out on the page.         

 

Give a Reason for the Windfall 
 

In Assignment 2, you had a windfall. Explain a practical reason for receiving the money. 

 Under the Windfall heading describe how you became $750 richer. 

  

What do you plan to 

do with the windfall?  
Explain your decision making. 

Use tables and graphs to 

support your reasoning. 

My Spending Plan 
 

Windfall 

 

 

Budget 

 

 

Plan 

 

 

Insights 
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Explain the Division of the Money in the Budget 

 Under the Budget heading, insert the pie graph: 

o From the Insert menu, click Chart.  Select From Sheets.  

o Double click the Budget file created using Google Sheets. 

Click Insert. 

o Select the pie graph. Click Import. 
 

 Use your skills to resize  the graph.  

 Explain your decisions: 

o What categories did you have? 

o Why did you decide to give some categories more money than others?  

 
 

 

Justify the Spending Plan 

 Under the Plan heading insert the bar graph: 

o From the Insert menu, click Chart.   Select From Sheets.  

o Double click the Budget file created using Google Sheets. 

o Select the bar graph. Click Import.  

 Explain your decisions:  

o What items are you planning to purchase? 

o Why do you think you made good spending decisions? 

  

My Spending Plan 
 

Windfall 

I received $750 unexpectedly from my Aunt as a graduation present. 

 

Budget 

I divided the budget into six categories including savings, charity, food, entertainment, 

clothing, and electronics. I gave electronics and clothing the most amount of money 

because I wanted to buy an outfit and a music system, and these things cost more 

money than items in other categories. 

Plan 

I plan to purchase clothing and a music system. I am also going to use the money to go 

to the movies and play laser tag. I put a bit of money aside for food, charity, and savings.  

 

I think this is a good way to spend the money. I will have the music system for a long time. 

The clothes I can wear to school. I can also have fun with my friends at the movies and 

laser tag. I like that I put money into savings, so that I can buy something I really want 

later. 

You can include your 

spending table. Look on the 

next page to find out how to 

copy it from Google Sheets 

into your report. 

Why are some categories 5% 

while others are over 30%? 
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Share Your Insights 

 Under the Insights heading explain what you learned.  

Pick two questions and answer them: 

o What problems did you encounter when making purchasing decisions?  

How did you solve them? 

o How does your spending plan connect to your money management style 

(Assignment 1)? 

o What are the advantages to putting money into Savings? 

o How did using a spreadsheet program help you make financial choices? 

o Is your spending plan slightly different from the original budget? If yes, why did 

you make changes? 

 

 
 

 

 

Copy Spending Plan Table into Report (Optional) 

 View the Plan sheet in Google Sheets. 

 Select the data starting from Grand Total (A2) to the last entry in the Total column.  

Do not include data in the Hyperlink column. 

 A B C D E F G 

1 Spending Plan 

2 Grand Total $750.00      

3        

4 Category Item Store Cost Tax Total Hyperlink 

5 clothing hat Hat Shop $29.99 $4.50 $34.49 www.hats.com/item 

6 clothing sweatshirt Sports Town $49.95 $7.49 $57.44 www.sports.net/item 

7 clothing jeans Jeans R Us $69.99 $10.50 $80.49 www.jeans.com/item 

8 clothing sweater Clothes City $39.99 $6.00 $45.99 www.clothes.ca/item 

9 food pizza Pizza Plus $23.00 $3.45 $26.45 www.pizza.com/menu 

10 food sandwich Super Subs $12.00 $1.80 $13.80 www.subs.com/menu 

11 entertainment laser tag Laser Fun $59.00 $8.85 $67.85 www.laserfun.com/pricing 

12 entertainment movies Movie Show $24.99 $3.75 $28.74 www.movies.com/deals 

13 electronics music system Best Sound $249.99 $37.50 $287.49 www.bestsound.com/sale 

14 charity donation Pet Shelter $40.00 $0.00 $40.00 www.petshelter.com 

15 savings savings Techno Bank $67.26 $0.00 $67.26 www.bank.com 

 From the Edit menu, click Copy.  

 View the Budget Report in Google Docs. 

Click to place the cursor. From the Edit menu, click Paste.  

 Choose Paste unlinked.  

If you choose Link to spreadsheet, any changes made in Sheets will update in the report. 

However, if the spreadsheet file is deleted the table will also be lost in the report. 

  Click Paste.  

 

Sign Out from Google Drive 

 

Insights 

One of the problems I encountered when making purchasing decisions was finding an 

item I really wanted, but it was more money than I had left in the category. This meant I 

would have to remove an item already on the spending plan and replace it with 

another. 

 

My Money Management Style is a saver. I found that this was also true when I was 

creating my spending plan. I ended up putting the extra money I did not spend into 

savings. 

Financial literacy is understanding 

money. What did you learn about 

how you manage money? 

Your teacher may want 

to see your spending 

plan in the report. 

Want to learn more about financial literacy? Try:  

Session 1 Extension Activity: Have Fun with Money Idioms 

Session 4 Extension Activity 2: Build Consumer Awareness 

Session 6 Extension Activity: Understand Credit and Debt 

http://www.pizza/
http://www.subs/
http://www.laserfun/
http://www.movies/
http://www.bestsound/
http://www.petshelter/
http://www.bank/
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Appendices 

 

Appendices 

 

Refer to the appendices for additional resources: 

Appendix A: Assessment Tools 

Appendix B: Contact Information 
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Spreadsheet Marking Sheet 

Budget Sheet – outlines the amount allocated for each category in the budget 

• sheet is named Budget 

• title describes the data 

• table summarizes the categories in the budget 

• budget has four or more categories, one category is savings 

• cells on the worksheet are formatted to make the data easy to read 

• sum of the categories totals $750 

• pie graph summarizes the budget 

• pie graph includes a title that describes the data  

• pie graph includes a labeled legend 

• each category is no less than 5% and no more than 50% of the budget 
/10 

 

Plan Sheet – summarizes the items to be purchased as part of a spending plan 

• sheet is named Plan 

• title describes the data and appears in merged cells 

• items on the spending plan total the budgeted amount of $750 

• conditional formatting is used to highlight the value of the grand total 

• table summarizes items: category, item, store, cost, tax, total, hyperlink 

• cells on the worksheet are formatted to make the data easy to read 

• dollar values display as currency in the cost, tax, total, and grand total cells 

• formulas calculate the taxes, item totals, and a grand total 

• sum of items in each category is in line with the budgeted amount 

• savings or charity do not include tax 
/10 

 

Chart 1 Sheet – illustrates the spending plan as a graph 

• bar or column graph summarizes the spending plan 

• title describes the data in the bar or column graph 

• legend is removed from the chart area 

• graph is formatted to make data easy to read 

• bar or column graph appears on its own sheet 
/5 

 

Comments: 

TOTAL: /25 
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Report Marking Sheet 

Report Design and Layout  

information on the report is organized using headings 

title and headings are formatted to make them stand out on the page 

spelling and grammar are correct 

/4 

Windfall  

practical reason is provided for windfall /1 

Budget  

categories in budget are outlined 

clear explanation behind allocation of funds for each category is provided 

pie graph of budget is included 

/5 

Plan  

description is provided of items on the spending plan 

reasoning for purchasing decisions is justified 

bar graph of budget is included 

/5 

Insights  

two insights describe learning 

insights demonstrate an understanding of money management 
/5 

Comments: 

/20 TOTAL: 

 

 
 



This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 
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My Spending Plan 

 

Windfall 

I received $750 from my Aunt as a graduation present. 

 

Budget 

I divided the budget into six categories including savings, charity, food, entertainment, clothing, 

and electronics. I gave electronics and clothing the most amount of money because I wanted to 

buy an outfit and a music system and these things cost more money than items in other 

categories. 

 
Plan 

I plan to purchase clothing and a music system. I am also going to use the money to go to the 

movies and play laser tag. I put a bit of money aside for food, charity, and savings. 

 

Grand Total $750.00     

      

Category Item Store Cost Tax Total 

charity donation Pet Shelter $40.00 $0.00 $40.00 

clothing hat Hat Shop $29.99 $4.50 $34.49 

clothing sweater Clothes City $39.99 $6.00 $45.99 

clothing sweatshirt Sports Town $49.95 $7.49 $57.44 

clothing jeans Jeans R Us $69.99 $10.50 $80.49 

electronics music system Best Sound $249.99 $37.50 $287.49 

entertainment movies Movie Show $24.99 $3.75 $28.74 

entertainment laser tag Laser Fun $59.00 $8.85 $67.85 

food sandwich Super Subs $12.00 $1.80 $13.80 

food pizza Pizza Plus $23.00 $3.45 $26.45 

savings savings Techno Bank $67.26 $0.00 $67.26 

I think this is a good way to spend the money. I will have the music system for a long time. The 

clothes I can wear to school. I can also have fun with my friends at the movies and laser tag. I 

like that I put money into savings, so that I can buy something I really want later. 
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Insights 

One of the problems I encountered when making purchasing decisions was finding an item I 

really wanted, but it was more money than I had left in the category. This meant I would have to 

remove an item already on the spending plan and replace it with another. 

  

My Money Management Style is a saver. I found that this was also true when I was creating my 

spending plan. I ended up putting the extra money I did not spend into savings. 
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